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Brevetti e marchi commerciali
La tecnologia Simple Plex di ProteinSimple è coperta da brevetti rilasciati e in attesa di approvazione negli 
Stati Uniti e in altri Paesi. Per ulteriori informazioni visitare il sito:
bio-techne.com/support/instrument-support/intellectual-property

ProteinSimple, il logo ProteinSimple, Simple Plex ed Ella sono marchi commerciali o marchi registrati di 
ProteinSimple. Altri marchi riportati su questi materiali appartengono ai rispettivi titolari.

Avvisi sulla proprietà intellettuale
Il presente manuale è coperto dalle leggi statunitensi e internazionali sul copyright. Nessuna parte del presente
manuale può essere riprodotta, modificata o trasmessa, in tutto o in parte, in alcuna forma o con alcun mezzo,
elettronico o meccanico, inclusi fotocopie, registrazioni o sistemi di archiviazione e recupero di informazioni,
senza autorizzazione scritta di ProteinSimple. ProteinSimple, col presente manuale, autorizza i propri clienti
che hanno acquistato Ella a effettuare un numero limitato di fotocopie o copie elettroniche del manuale senza 
apportare modifiche, se tali utilizzi sono limitati allo scopo di installare o utilizzare Ella.

Il software Simple Plex è soggetto alle licenze stabilite nei Termini e condizioni standard di ProteinSimple.

mailto:support@bio-techne.com
http://bio-techne.com/support/instrument-support/intellectual-property
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Ella - Esclusione di garanzia
Ad eccezione di quanto espressamente previsto nel contratto di licenza o nel preventivo del software 
ProteinSimple, i prodotti venduti e i servizi forniti da ProteinSimple vengono forniti “così come sono” e “secondo 
disponibilità” senza garanzie di alcun tipo. ProteinSimple e i suoi fornitori non garantiscono la sicurezza, la 
privacy o l’accuratezza dei dati forniti tramite i prodotti o i servizi e l’utente accetta che l’uso di tali dati da parte 
dell’utente sia a suo rischio esclusivo. Nella misura massima consentita dalla legge applicabile, ProteinSimple e i 
suoi fornitori declinano ogni e qualsiasi garanzia, esplicita, implicita o legale, inclusa, a titolo esemplificativo ma 
non esaustivo, qualsiasi garanzia di commerciabilità, titolo, non violazione o idoneità a uno scopo particolare.

Ambito
Ai fini del corretto funzionamento del sistema e/o di tutte le sue parti, le istruzioni contenute nel presente manuale 
devono essere seguite rigorosamente ed espressamente da personale esperto. Tutto il contenuto di questa 
guida deve essere interamente letto e compreso prima di azionare il sistema o qualsiasi sua parte. La mancata 
lettura, piena comprensione e osservanza di tutto il contenuto di questa guida prima di azionare il sistema o i 
suoi componenti può causare danni all’apparecchiatura o ai suoi componenti e lesioni a qualsiasi persona che ne 
faccia uso.

Scopo previsto
Lo scopo previsto dello strumento Ella è il seguente:

Ella è uno strumento non automatizzato destinato all’uso diagnostico in vitro con un dosaggio Ella 
supportato per l’esecuzione della diagnostica con immunodosaggio. Lo strumento Ella esegue il 
trattamento di campioni, reagenti e tamponi di lavaggio, nonché misura e ordina i segnali di fluorescenza, 
utilizzando un kit di dosaggio Ella supportato. Lo strumento Ella deve essere utilizzato da personale di 
laboratorio addestrato.

Lo strumento Ella deve essere utilizzato in ambienti sanitari professionali (ad es. laboratori clinici, ospedali, 
cliniche). Il sistema Ella non è destinato all’uso per le analisi decentrate o per l’autotest. L’uso improprio e 
ragionevolmente prevedibile del prodotto include: 1. Utilizzo da parte di utenti non addestrati 2. Utilizzo con 
cartucce non supportate.

Principio del test
Lo strumento Ella utilizza il principio di test dell’immunodosaggio a sandwich che prevede i seguenti passaggi.

In primo luogo, l’antigene target viene catturato utilizzando un nano-reattore in vetro in fase solida rivestito 
con un anticorpo di cattura specifico per l’antigene. Il campione viene fatto passare attraverso la cartuccia 
affinché l’antigene target si leghi all’anticorpo di cattura. Successivamente nella cartuccia viene introdotto un 
anticorpo di rilevamento, coniugato a un marcatore fluorescente, che si lega all’antigene formando un complesso 
a “sandwich”. Dopo aver allontanato le sostanze non legate tramite un lavaggio, la cartuccia viene letta dallo 
strumento e vengono riportate le relative unità fluorescenti. L’intensità del segnale è direttamente proporzionale 
alla quantità di antigene presente nel campione. Confrontando il segnale ottenuto dal campione con una curva 
standard generata a partire da concentrazioni note dell’antigene, è possibile determinare la concentrazione 
dell’antigene nel campione. Questo principio consente di effettuare una quantificazione altamente specifica e 
sensibile degli antigeni in vari campioni.

Avvertenze e rischi residui
Non identificati.
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Descrizioni di etichette e simboli

Simbolo Descrizione

ATTENZIONE 
Fare riferimento alla documentazione allegata

Marchio di approvazione NRTL 
Approvazione della sicurezza elettrica ai sensi delle norme UL61010-1:2012; EN61010-1:2010; 
CAN/CSA C22.2 61010-1:2012

Garanzia, da parte del fabbricante, che il prodotto soddisfa i requisiti essenziali di tutte le direttive 
UE pertinenti.

Simbolo RAEE 
Raccolta differenziata per apparecchiature elettriche ed elettroniche.

Fabbricante 
Indica il fabbricante del dispositivo medico, come definito nel regolamento IVDR (2017/746).

Dispositivo medico diagnostico in vitro 
Indica un dispositivo medico destinato all’uso come dispositivo medico diagnostico in vitro.

Numero di catalogo 
Indica il numero di catalogo del fabbricante, che permette di identificare il dispositivo medico.

Identificativo univoco del dispositivo 
Codice numerico o alfanumerico univoco che facilita il tracciamento e l’identificazione del 
dispositivo
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Capitolo 1

Informazioni di carattere generale 
su Ella
Panoramica sul sistema
Ella™ è un sistema a cartucce completamente automatizzato che consente ai ricercatori di misurare biomarcatori 
in vari tipi di campioni. Ella, utilizzato insieme alla tecnologia microfluidica (cartucce Simple Plex™), consente 
di effettuare misurazioni di un singolo analita, di più analiti in parallelo (multianalita) e misurazioni multiplex. I 
ricercatori possono anche configurare le cartucce Simple Plex in modo che siano univoche per la propria ricerca. 

Il sistema Ella consente di effettuare le seguenti procedure: 

•	 Esecuzione automatica di un protocollo di immunodosaggio 

•	 Acquisizione ed elaborazione automatica dei dati 

•	 Visualizzazione e analisi dei dati di fluorescenza e concentrazione per analita e per campione 

•	 Estrazione e salvataggio delle informazioni relative alla fluorescenza e alla concentrazione ai fini dell’analisi 
tramite una specifica applicazione 

ATTENZIONE: il sistema Ella non è destinato all’uso per le analisi decentrate o per l’autotest.

Specifiche
In questa sezione si descrivono le specifiche di Ella, comprese le condizioni ambientali, i valori elettrici nominali, 
le condizioni fisiche, la classificazione laser e il fusibile esterno 

TA B E L L A //  02

Specifiche dello strumento

Condizioni ambientali
Solo per uso in ambienti interni
Altitudine fino a 2000 m (6500 ft) 
Temperatura: da 18 °C a 30 °C (da 65 °F a 86 °F) 
Umidità: dal 15 all’80% di umidità relativa, in ambienti interni, senza condensa

Condizioni di 
conservazione e 
trasporto

Temperatura: da -18 °C a 50 °C (da 0,4 °F a 122 °F)
Umidità: U.R. ≤ 85% senza condensa 

Condizioni fisiche
Dimensioni complessive: 37 cm (L) x 54 cm (P) x 26 cm (A)

14,6 in (L) x 21,3 in (P) x 10,2 in (A)
Peso: 18,2 kg (40,1 lb)

Fusibile esterno Fusibile principale (ingresso apparecchio): 4 A, 250 V; IEC 60127 classificato come T4AL 250 V

Valori elettrici nominali 100-240 V (CA), 300 VA, 45/65 Hz, Categoria di installazione di Classe I (sovratensione) II 
NOTA: i valori elettrici elencati sono nominali

Specifiche dei test 
elettrici

Schema CB: IEC 61010-1:2010

Schema “CUE” TÜV SÜD:
CAN/CSA-C22.2 N. 61010-1:2012
UL 61010-1:2012/R:2019-07
EN 61010-1:2012/R:2019-07
EN 60825-1:2014

Prodotto laser di classe 1 conforme alle norme IEC 60825-1:2014 e EN 60825-1:2014

Conforme alle norme di prestazione della FDA per i prodotti laser 21 CFR 1040.10 e 1040.11, 
fatta eccezione per le deviazioni ai sensi dell’Avviso sui laser n. 50, datato 24 giugno 2007.
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ATTENZIONE: non rimuovere il coperchio principale di Ella; i componenti presenti all’interno non sono 
riparabili dall’utente, il quale potrebbe essere esposto all’alta tensione.

ATTENZIONE: l’uso di comandi, la regolazione o l’esecuzione di procedure diverse da quelle specificate 
nel presente manuale può comportare l’esposizione a luce laser pericolosa.

Precauzioni e avvertenze
Nelle sezioni seguenti si descrivono le precauzioni di sicurezza da osservare durante l’utilizzo di Ella.

Tali precauzioni includono:

•	 Sicurezza generale

•	 Sicurezza elettrica

•	 Sicurezza della luce laser

Precauzioni generali di sicurezza
ATTENZIONE: l’operatore di Ella deve essere addestrato da personale qualificato al corretto funzionamento dello 
strumento e deve essere consapevole dei problemi di sicurezza 

Precauzioni di sicurezza elettrica
In questa sezione si descrivono le precauzioni di sicurezza elettrica relative ai collegamenti elettrici e al fusibile di 
Ella, nonché i rischi correlati all’alta tensione.

Collegamenti elettrici
Collegare Ella a un circuito con messa a terra in grado di erogare almeno:

•	 15 A per una fonte di alimentazione da 100 V a 120 V

•	 12 A per una fonte di alimentazione da 200 V a 240 V. Per ulteriori informazioni, vedere l’etichetta del 
fabbricante sul retro di Ella.

Fusibile
Il portafusibile di ingresso primario si trova sul lato destro del retro di Ella e contiene un fusibile ritardato da 
4 A, 250 V. Il portafusibile è progettato per accogliere un fusibile da 5 mm x 20 mm. Le specifiche dei fusibili di 
ricambio devono soddisfare la norma IEC 60127 ed essere classificati come T4AL 250 V.

ATTENZIONE: prima di sostituire il fusibile, spegnere Ella e scollegare il cavo di alimentazione. Se un 
fusibile viene sostituito spesso, Ella potrebbe avere un problema elettrico. Non utilizzare Ella. Si potrebbe 
essere esposti a scosse elettriche. Per assistenza, contattare il Supporto tecnico Bio-Techne.

Pericoli e precauzioni correlati all’alta tensione
Il computer e il monitor contengono componenti elettronici ad alta tensione. Prima di aprire il computer o il 
monitor, consultare le relative precauzioni.

Precauzioni di sicurezza relative alla luce laser

Ella è uno strumento laser di Classe 1 e include un laser di Classe 3B che opera a una lunghezza d’onda di 
640 nm. In base alle procedure operative specificate, Ella non consente all’operatore di essere esposto alla luce 
laser. Il design del laser del sistema Ella è conforme alla norma IEC (EN) 60625-1-2014.
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ATTENZIONE: non tentare di accedere alle parti interne di Ella attraverso le aperture del sistema. 
L’esposizione alla luce laser può causare lesioni. Ad esempio, la visualizzazione diretta della luce laser 
può causare cecità.

ATTENZIONE: l’uso di comandi o regolazioni, o l’esecuzione di procedure diverse da quelle specificate nel 
presente manuale, può comportare l’esposizione a radiazioni pericolose.

Osservare le seguenti precauzioni:

•	 Non rimuovere il coperchio principale di Ella. I componenti presenti all’interno non sono riparabili dall’utente, il 
quale potrebbe essere esposto alla luce laser.

•	 Non continuare a utilizzare Ella se il coperchio principale o il coperchio della cartuccia risultano danneggiati 
e non sono più a prova di luce. Per predisporre la riparazione, contattare immediatamente il supporto tecnico 
Bio-Techne.

Segnalazione di eventi avversi
Se è necessario segnalare un incidente grave verificatosi con questo dispositivo medico, contattare il sito di 
produzione (fare riferimento alle informazioni di contatto del fabbricante) e l’autorità nazionale competente in cui 
risiedono il paziente e l’utilizzatore. 

Qualifiche dell’utilizzatore
Il personale che utilizza ed effettua la manutenzione o la pulizia del sistema Ella deve essere addestrato alle 
pratiche standard di sicurezza di laboratorio e deve attenersi a tali pratiche quando maneggia lo strumento. 
Inoltre, deve essere pienamente qualificato e addestrato a utilizzare il sistema Ella, deve aver letto e compreso 
pienamente le istruzioni contenute nel presente manuale d’uso e avere familiarità con i regolamenti e le direttive 
di sicurezza applicabili per l’ambiente di utilizzo.

Installazione di Ella
Per poter utilizzare il sistema Ella, è richiesta la presenza di un dipendente Bio-Techne addestrato alla corretta 
installazione e al corretto funzionamento del sistema. Ella è pronto per l’uso solo dopo la ricezione del modulo 
firmato da un dipendente Bio-Techne che attesti la corretta esecuzione della procedura IQ OQ.

Spostamento di Ella
Ella è uno strumento ottico sensibile e può subire danni se spostato in modo improprio. La caduta può 
danneggiare lo strumento. Spegnere sempre Ella prima di spostarlo. Per indicazioni sulla preparazione di Ella a 
uno spostamento, consultare le istruzioni “Preparazione di Ella per la spedizione” a pagina 22.

ATTENZIONE: questo prodotto richiede il sollevamento da parte di due persone. Il sollevamento di carichi 
pesanti può causare lesioni. Adottare tecniche di sollevamento adeguate.

ATTENZIONE: non posizionare Ella vicino a dispositivi che possono emettere vibrazioni significative 
(ad es. un vortex) in quanto potrebbero interferire con le misurazioni.

Smaltire in conformità ai regolamenti locali, regionali, nazionali, territoriali, provinciali e internazionali. 
Consultare le schede dati di sicurezza (SDS) per determinare lo smaltimento sicuro dei materiali per la 
propria regione.

Smaltimento di Ella
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Interconnessioni: da Ella al computer
NOTA: è possibile collegare e controllare un solo strumento Ella per PC. Non è possibile collegare più strumenti 
allo stesso PC.

1.	 Cavo di alimentazione CA 
Viene utilizzato per fornire alimentazione CA al sistema Ella. Il cavo di alimentazione CA deve essere dotato di 
un connettore femmina IEC 320 a un’estremità (collegamento Ella) e di una spina maschio specifica per il Paese 
all’altra estremità. I cavi di alimentazione devono essere omologati UL e certificati CSA con un valore nominale 
in amp che soddisfi le specifiche elettriche di Ella.

2.	Cavo Ethernet (nero) 
Serve per la comunicazione con la videocamera ad alta velocità all’interno dello strumento.

3.	Cavo USB 
Serve per la comunicazione con tutte le altre funzionalità dello strumento.

Interconnessioni del sistema Ella
La Figura 02 presenta una panoramica esaustiva sulle interconnessioni tra Ella, il PC, il monitor, la tastiera e il 
lettore di codici a barre. Fare riferimento alle istruzioni di configurazione specifiche per Ella e il PC in uso.

F I G U R A //  0 1

Collegamenti di Ella

F I G U R A //  02

Connessione di Ella al PC e alle periferiche di supporto

Cavo USB

Cavo Ethernet

Cavo di alimentazione CA

PCElla
Cavo USBCavo USB

Cavo Ethernet

Alimentazione CA

Lettore di codici a barre

Periferiche wireless

Alimentazione CA
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Requisiti minimi IT e hardware
Non sono previsti requisiti di rete IT per il sistema Ella. È sconsigliabile stabilire connessioni di rete a Ella. Ella 
funziona come sistema autonomo ed è progettato per funzionare indipendentemente da una connessione di rete. 
Qualsiasi connessione a una rete, sia intra- che inter-rete, è a rischio. 

Ella non richiede hardware aggiuntivo per il funzionamento. Il collegamento di hardware aggiuntivo a Ella è 
sconsigliato e viene eseguito a rischio dell’utilizzatore.

Misure di sicurezza IT
Il cliente deve:

1.	 Controllare l’accesso fisico allo strumento per impedire l’accesso non autorizzato 

2.	Controllare l’accesso alla porta USB del dispositivo solo su supporti rimovibili affidabili 

Come contattare il Servizio clienti
Per informazioni sull’assistenza clienti o sugli ordini, contattare Il Servizio clienti. 
Per assistenza tecnica, contattare il supporto tecnico.

Sito Web		  www.bio-techne.com/brands/proteinsimple

Servizio 
clienti

Telefono			  1-408-510-5500 
				    1-888-607-9692 (numero verde, solo per Stati Uniti e Canada)

E-mail 			   orders@proteinsimple.com

Supporto 
tecnico

Telefono			  1-408-510-5500 
				    1-888-607-9692 (numero verde, solo per Stati Uniti e Canada)

E-mail			   support@bio-techne.com
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Capitolo 2

Avvio di Ella
Introduzione
Ella è un sistema a cartucce completamente automatizzato che consente di eseguire immunodosaggi multianalita 
con la specificità di un ELISA single-plex tradizionale (test immunoassorbente legato ad un enzima).

Il sistema Ella consente di effettuare le seguenti procedure:

•	 Esecuzione automatica di un protocollo di immunodosaggio

•	 Acquisizione ed elaborazione automatica dei dati relativi all’intensità

•	 Visualizzazione e analisi dei dati relativi a intensità e concentrazione

•	 Estrazione e salvataggio delle informazioni relative all’intensità e alla concentrazione ai fini dell’analisi con una 
specifica applicazione

Componenti del sistema Ella
Ella è costituito da cinque componenti principali:

1.	 Strumento/lettore Ella

2.	Lettore di codici a barre

3.	Personal computer

4.	Software Runner CE

5.	Cartuccia di verifica (le cartucce Simple Plex sono disponibili separatamente)

Ella
Uno dei componenti principali del sistema Ella è un analizzatore da banco senza sistema fluidico integrato che 
riduce notevolmente i rifiuti e la manutenzione preventiva.

Progettato tenendo conto della filosofia “load and go” (analisi immediata), Ella controlla la cartuccia per il 
dosaggio microfluidico manipolando con precisione volumi, velocità di flusso e schemi di flusso senza intervento 
umano. Dopo aver effettuato la parte della sessione analitica relativa al dosaggio, Ella esegue automaticamente 
la scansione a fluorescenza, l’elaborazione dei dati grezzi e calcola le RFU (unità relative di fluorescenza) e le 
concentrazioni per analita e per campione. Lo strumento è dotato di un cavo di alimentazione.

Lettore di codici a barre
Il sistema Ella include un lettore palmare di codici a barre generico in grado di eseguire la scansione 
omnidirezionale di codici a barre 1D e 2D. Ogni kit di cartucce spedito da Bio-Techne è etichettato con un codice a 
barre 2D a matrice di dati che contiene tutti i dati pertinenti al kit di cartucce, tra cui:

•	 Informazioni sul numero di lotto

•	 Informazioni sul pannello dei biomarcatori

•	 Informazioni sulla configurazione delle cartucce
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L’analisi di ogni cartuccia inizia con la scansione del codice a barre del kit della cartuccia, in modo da fornire 
all’utilizzatore tutte le informazioni essenziali sul kit della cartuccia e al software tutti i dati necessari per eseguire 
l’analisi della cartuccia e l’elaborazione dei dati grezzi.

Personal computer
Con Ella è incluso un PC che consente di controllare il sistema. Sono forniti un cavo USB e un cavo di rete per il 
collegamento a Ella.

Software Simple Plex 
Runner CE è un sistema software senza interfaccia grafica destinato all’impiego per l’analisi delle cartucce. La 
GUI viene sviluppata dallo sviluppatore del dosaggio. Runner CE è preinstallato sul PC incluso nel sistema Ella. 
Per informazioni o assistenza sullo sviluppo di una GUI, contattare Bio-Techne. 

Cartuccia di verifica
La cartuccia di verifica viene fornita come riferimento riutilizzabile necessario per eseguire un autotest dello 
strumento. Per i dettagli, vedere “Autotest del sistema Ella” a pagina 21.

Cartucce e dosaggi Simple Plex
La cartuccia IVD pronta all’uso è disponibile nel formato multianalita da 32 campioni (vedere la Figura 03). La 
cartuccia viene sviluppata con un pannello specifico per la ricerca da effettuare, che consente la scansione 
del codice a barre, l’inserimento dei campioni e del tampone all’interno della cartuccia, il posizionamento della 
cartuccia nel portacartuccia di Ella e l’analisi della cartuccia. Le cartucce e i dosaggi Simple Plex non sono inclusi 
nel sistema Ella. Utilizzare esclusivamente con cartucce e kit di dosaggio etichettati per l’uso con lo strumento 
Ella. 

Ogni cartuccia è dotata di numerosi pozzetti per i campioni. Ogni pozzetto per il campione presenta fino a 4 canali 
dedicati. Un singolo canale contiene tre nano-reattori in vetro (GNR), funzionalizzati con l’anticorpo di cattura, in 
modo da ottenere tre risultati refertabili per ciascun analita del campione. Il GNR contiene l’immunodosaggio ed è 
basato sui reagenti R&D Systems per garantire una qualità elevata e una sensibilità riproducibile. La raccolta dei 
GNR in un determinato canale, in uno specifico pozzetto del campione, su una data cartuccia, è alla base della 
serie di misurazioni prodotte durante l’analisi di una cartuccia Simple Plex.

F I G U R A //  03

Cartucce analizzate nel sistema Ella.

ATTENZIONE: qualsiasi configurazione che non utilizzi il software Runner CE e le cartucce con marcatura 
CE supportate non è conforme alla configurazione del sistema con marcatura CE.  

Cartuccia di verifica

V E R I F I C A T I O N  C A R T R I D G E
BUFFER 1mL

1 2 3 4 5 6 7 8

BUFFER 1mL

BUFFER 1mL

9 10 11 12 13 14 15 16

BUFFER 1mL

C A L I B R A T I O N  C A R T R I D G E

DYE
25 µL

DYE
25 µL

BUFFER 1mL

1 2 3 4 5 6 7 8

BUFFER 1mL

BUFFER 1mL

9 10 11 12 13 14 15 16

BUFFER 1mL

BUFFER 1mL

17 18 19 20 21 22 23 24

BUFFER 1mL

BUFFER 1mL

25 26 27 28 29 30 31 32

BUFFER 1mL

SN 3456 2025-04-30 TNF-a 2nd gen
Car# 10:117265     VO: 9649     Date: 4/8/2025

Cartuccia di test e 
calibrazione

V E R I F I C A T I O N  C A R T R I D G E
BUFFER 1mL

1 2 3 4 5 6 7 8

BUFFER 1mL

BUFFER 1mL

9 10 11 12 13 14 15 16

BUFFER 1mL

C A L I B R A T I O N  C A R T R I D G E

DYE
25 µL

DYE
25 µL

BUFFER 1mL

1 2 3 4 5 6 7 8

BUFFER 1mL

BUFFER 1mL

9 10 11 12 13 14 15 16

BUFFER 1mL

BUFFER 1mL

17 18 19 20 21 22 23 24

BUFFER 1mL

BUFFER 1mL

25 26 27 28 29 30 31 32

BUFFER 1mL

SN 3456 2025-04-30 TNF-a 2nd gen
Car# 10:117265     VO: 9649     Date: 4/8/2025

Cartuccia Simple Plex 32x4

32 campioni, 4 analiti

V E R I F I C A T I O N  C A R T R I D G E
BUFFER 1mL

1 2 3 4 5 6 7 8

BUFFER 1mL

BUFFER 1mL

9 10 11 12 13 14 15 16

BUFFER 1mL

C A L I B R A T I O N  C A R T R I D G E

DYE
25 µL

DYE
25 µL

BUFFER 1mL

1 2 3 4 5 6 7 8

BUFFER 1mL

BUFFER 1mL

9 10 11 12 13 14 15 16

BUFFER 1mL

BUFFER 1mL

17 18 19 20 21 22 23 24

BUFFER 1mL

BUFFER 1mL

25 26 27 28 29 30 31 32

BUFFER 1mL

SN 3456 2025-04-30 TNF-a 2nd gen
Car# 10:117265     VO: 9649     Date: 4/8/2025
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Avvio e spegnimento del sistema Ella
Seguire le procedure riportate in questa sezione che descrivono come posizionare, avviare e spegnere Ella.

NOTA: durante il posizionamento di Ella, prestare attenzione affinché la superficie posteriore abbia uno spazio 
libero adeguato, in modo che la mano dell’operatore possa accedere all’interruttore e al cavo di alimentazione. 
Con l’operatore rivolto verso la parte anteriore di Ella, l’interruttore e il cavo di alimentazione si trovano sul 
pannello posteriore, in basso a sinistra.

Avvio del sistema
Per avviare Ella:

1.	 Accendere Ella.

2.	Accendere il computer e il monitor di Ella.

3.	Accedere al PC ed eseguire l’avvio 

4.	Dopo l’accensione di Ella, si accende l’indicatore 
di stato (Figura 04). Per una descrizione 
dell’indicatore di stato, vedere la Tabella 3.

Accensione di Ella
Premere l’interruttore di alimentazione sul pannello 
posteriore di Ella.

Spegnimento del sistema
Per spegnere Ella:

1.	 Spegnere il computer di Ella

2.	Spegnere Ella premendo l’interruttore di 
alimentazione sul pannello posteriore.

TA B E L L A //  03

Indicazioni della spia di stato di Ella.
F I G U R A //  04

Spia di stato di Ella.

Colore della spia Stato

●   Verde Ella è alimentato e pronto all’uso

●   Blu Ella sta analizzando una 
cartuccia

●   Rosso 
lampeggiante

Si è verificato un errore (Ella può 
emettere facoltativamente un 
allarme acustico)
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Capitolo 3

Analisi delle cartucce Simple Plex
Introduzione
La sezione seguente ha solo scopo informativo. Per ulteriori informazioni su come analizzare la cartuccia, 
consultare la scheda delle specifiche e la documentazione del prodotto. 

Analisi di una cartuccia
Per analizzare una cartuccia, sono necessari i seguenti materiali:

•	 Campioni

•	 Kit della cartuccia con codice a barre (Figura 05) contenente:

a.	 tampone di lavaggio A

b.	uno o più componenti di diluente per il campione

c.	 cartuccia

La sequenza analitica tipica è la seguente:

1.	 Preparazione dei reagenti

2.	Preparazione della cartuccia

3.	Configurazione e analisi con Ella

F I G U R A //  05

Kit della cartuccia.

Etichette con codice a barre
Etichetta del kit

Si trova esternamente al sacchetto della cartuccia (cerchiata nella Figura 05).

Kit confezionato Tampone di lavaggio e diluente per 
campione

Cartuccia nel sacchetto, inclusa 
l’etichetta con codice a barre 
(cerchiata in rosso)
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Etichetta della cartuccia

L’etichetta con il codice a barre della cartuccia (vedere la Figura 06) è applicata direttamente sulla cartuccia e 
serve a ricondurre la cartuccia al relativo kit. Questa etichetta viene utilizzata per confermare che la cartuccia 
analizzata corrisponde al relativo kit. 

I codici a barre con gli ID della cartuccia si trovano sul lato anteriore della cartuccia vicino al bordo inferiore, come 
mostrato nella Figura 06.

Preparazione dei campioni e dei reagenti
Campioni di plasma (EDTA o eparina) e siero

I campioni di siero e plasma, preparati secondo il protocollo consigliato nella scheda delle specifiche del dosaggio 
e non contenenti particolato visibile, non richiedono ulteriore centrifugazione prima dell’uso in un dosaggio 
Simple Plex.

Per i campioni di siero e plasma contenenti particolato visibile, è consigliabile rimuovere il particolato mediante 
centrifugazione e diluire secondo le istruzioni riportate nelle schede delle specifiche del dosaggio. Il metodo 
seguente è progettato per preservare il campione, ma può essere modificato secondo necessità in base alla 
disponibilità del campione e al contenuto di particolato. Il metodo seguente simula la preparazione del campione 
per la diluizione minima richiesta (MRD) 1:2 utilizzata nella maggior parte dei dosaggi Simple Plex. Per garantire 
l’accuratezza con fattori di diluizione più alti, può essere necessaria una diluizione seriale.

Centrifugazione per i campioni di siero e plasma

1.	 Dispensare un’aliquota da 35 μl di siero o plasma in una provetta per microcentrifuga.

2.	Centrifugare a 8.000-10.000 g per almeno 4 minuti.

3.	Dispensare un’aliquota da 30 μl di diluente per campione appropriato in un’altra provetta per microcentrifuga.

4.	Una volta completata la centrifugazione, rimuovere 30 μl di campione prestando attenzione a non intaccare il 
pellet sul fondo.

5.	Aggiungere i 30 μl di campione centrifugato all’aliquota da 30 μl di diluente e miscelare con cura.

6.	Pipettare 50 μl di campione diluito 1:2 nel pozzetto della cartuccia specificato.

Altri tipi di campioni

Le diluizioni ottimali devono essere determinate dall’utilizzatore finale.

V E R I F I C A T I O N  C A R T R I D G E
BUFFER 1mL

1 2 3 4 5 6 7 8

BUFFER 1mL

BUFFER 1mL

9 10 11 12 13 14 15 16

BUFFER 1mL

C A L I B R A T I O N  C A R T R I D G E

DYE
25 µL

DYE
25 µL

BUFFER 1mL

1 2 3 4 5 6 7 8

BUFFER 1mL

BUFFER 1mL

9 10 11 12 13 14 15 16

BUFFER 1mL

BUFFER 1mL

17 18 19 20 21 22 23 24

BUFFER 1mL

BUFFER 1mL

25 26 27 28 29 30 31 32

BUFFER 1mL

SN 3456 2025-04-30 TNF-a 2nd gen
Car# 10:117265     VO: 9649     Date: 4/8/2025

V E R I F I C A T I O N  C A R T R I D G E
BUFFER 1mL

1 2 3 4 5 6 7 8

BUFFER 1mL

BUFFER 1mL

9 10 11 12 13 14 15 16

BUFFER 1mL

C A L I B R A T I O N  C A R T R I D G E

DYE
25 µL

DYE
25 µL

BUFFER 1mL

1 2 3 4 5 6 7 8

BUFFER 1mL

BUFFER 1mL

9 10 11 12 13 14 15 16

BUFFER 1mL

BUFFER 1mL

17 18 19 20 21 22 23 24

BUFFER 1mL

BUFFER 1mL

25 26 27 28 29 30 31 32

BUFFER 1mL

SN 3456 2025-04-30 TNF-a 2nd gen
Car# 10:117265     VO: 9649     Date: 4/8/2025
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Codice a barre con ID della cartuccia.

Codice a barre con ID della cartuccia: vista anteriore completa della cartuccia 32x4 (a sinistra). La vista ingrandita dettagliata mostra i 
dettagli della cartuccia e il codice a barre (a destra).
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Preparazione della cartuccia
NOTA: quando si utilizzano le cartucce, si consiglia di indossare sempre i guanti e rimuovere il supporto in 
plastica solo immediatamente prima di posizionare la cartuccia nel sistema Ella.

Procedura

1.	 Eseguire la scansione del codice a barre del kit situato esternamente al sacchetto sottovuoto della cartuccia.

2.	Rimuovere la cartuccia dal sacchetto sottovuoto.

3.	Eseguire la scansione del codice a barre della cartuccia.

4.	Pipettare i volumi all’interno della cartuccia nel seguente ordine:

a.	 Tampone di lavaggio, come descritto sul foglietto illustrativo della cartuccia.

b.	Campione diluito, come indicato sul pozzetto della cartuccia.

5.	Rimuovere il rivestimento protettivo dal fondo della cartuccia.

6.	Collocare la cartuccia nel portacartuccia di Ella. 
 
NOTA: dopo aver rimosso il rivestimento protettivo, prestare attenzione a non toccare il fondo della cartuccia e 
a non posizionare la cartuccia su alcuna superficie.

7.	Chiudere il morsetto della cartuccia e il coperchio del sistema.

La sequenza di preparazione di una cartuccia è illustrata nella Figura 07.

A. Preparazione della cartuccia

1.	 Scansione del codice a 
barre.

F I G U R A //  07

Guida visiva dettagliata per la preparazione di una cartuccia da analizzare nel sistema Ella.

2.	Rimozione del 
rivestimento protettivo 
della cartuccia.

3.	Scansione del codice a 
barre della cartuccia per 
conferma (opzionale).

4.	Caricamento del 
tampone.

5.	Caricamento del 
campione.

6.	Rimozione del 
rivestimento 
interno protettivo.
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B. Caricamento della cartuccia nel sistema Ella

F I G U R A //  07

Guida visiva dettagliata per la preparazione di una cartuccia da analizzare nel sistema Ella (segue).

1.	 Apertura dello sportello di Ella.

2.	Apertura del morsetto della 
cartuccia.

3.	Lo sportello di Ella e il morsetto 
della cartuccia sono entrambi 
aperti.

4.	Caricamento della cartuccia 
all’interno di Ella.

5.	Chiusura del morsetto della 
cartuccia.

6.	Chiusura dello sportello.

ATTENZIONE: prestare attenzione a non versare liquidi nel vano della cartuccia 

Simple Plex Runner CE
Nella barra delle applicazioni sul desktop è disponibile, 
tra le icone nascoste, una versione di Runner CE senza 
interfaccia utente (vedere la Figura 08). Questa può 
essere utilizzata per modificare le impostazioni del 
Runner, spostare la pedana di Ella o esportare file 
diagnostici o altri file di dati. 

F I G U R A //  0 8

Icona Simple Plex Runner CE.

Facendo clic su Settings > Application (Impostazioni > 
Applicazione) dal menu, viene visualizzata la finestra 
di dialogo Settings (Impostazioni), come mostrato nella 
Figura 09. Facendo clic su una riga nella finestra di 
dialogo delle impostazioni, nella parte inferiore della 
finestra di dialogo viene visualizzata una descrizione 
dettagliata della voce selezionata. Queste descrizioni 
sono fornite nella Tabella 04 come riferimento. Se si 
apportano modifiche, viene abilitato il pulsante Save 
(Salva).
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Finestra di dialogo delle impostazioni di 
Simple Plex Runner CE.
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Rinominare lo strumento Ella nelle impostazioni di Simple Plex Runner CE.

Facendo clic su Settings > Analyzer > Description (Impostazioni > Analizzatore > Descrizione) dal menu, viene 
visualizzata una finestra di dialogo che può essere utilizzata per rinominare lo strumento Ella (Figura 10). Il 
nuovo nome dello strumento viene scritto nel software integrato dello strumento e rimarrà inalterato anche dopo 
un’eventuale sostituzione del computer. Questo nome sarà associato ai file .cydat generati dallo strumento.

Parametro Descrizione

Use21CFRPart11Mode 
(UsaModalità21CFRParte11)

Consente di determinare se utilizzare o meno il supporto 21 CFR Parte 11 (accessi, audit 
trail, crittografia dati, ecc.). Affinché l’impostazione diventi effettiva, è necessario attivare 
il supporto 21 CFR Parte 11.

AutoLockInactivityMinutes 
(MinutiInattivitàBloccoAutomatico)

Consente di stabilire la durata di un periodo di inattività prima che la schermata 
dell’applicazione si blocchi automaticamente in modalità 21 CFR Parte 11. Per disattivare 
questa funzione, impostare il valore su 0.

LogoutWhenDone (DisconnettiQuandoFine)
Quando è true (vero) (impostazione predefinita), l’utente corrente viene disconnesso dopo 
aver selezionato Done (Fine) nel pannello Kit Results (Risultati del kit). Quando è false (falso), 
l’utente corrente rimane connesso e l’applicazione passa al riquadro New Kit (Nuovo kit).

AllowOutputFilePathChange 
(ConsentiModificaPercorsoFileRisultati)

Quando è false (falso), il nome e la posizione del file dei risultati del kit non possono 
essere modificati. Questo vale anche per il file di esportazione LIMS generico (se 
abilitato). Questa impostazione si applica solo in modalità 21 CFR Parte 11.

KitResultsFileDefaultFolder 
(CartellaPredefinitaFileRisultatiKit) La directory comune in cui generare il file dei risultati del kit (estensione *.cydat).

AlwaysShow3DecimalsFor 
Concentration 
(MostraSempre3DecimaliPerConcentrazione)

Consente di mostrare sempre 3 decimali per la concentrazione. L’impostazione 
predefinita riguarda il numero di decimali visualizzati in base al numero di cifre 
significative presenti nella misurazione. Questa impostazione consente di modificare 
anche la modalità di esportazione dei valori di concentrazione.

GnrFilter (FiltroGnr)
Il filtro utilizzato per selezionare i GNR risultanti. None (Nessuno) indica verranno 
selezionati tutti i GNR trovati. Se il CV percentuale per tutti e tre i GNR supera la soglia 
specificata, le impostazioni RFU e Concentration CV (CV concentrazione) consentono di 
eseguire una rimozione anomala dei GNR.

GnrFilterPercentCVThreshold 
(SogliaCVPercentualeFiltroGnr) La soglia del CV percentuale utilizzata da GnrFilter (FiltroGnr).

UseSampleStandardDeviation 
(UsaDeviazioneStandardCampione)

Preferenza utilizzata per calcolare il CV percentuale. Se si seleziona questa opzione, 
viene utilizzata la deviazione standard del campione. In caso contrario, viene utilizzata la 
deviazione standard della popolazione (impostazione predefinita).

ResultWarning (AvvertenzaRisultato)

Questa impostazione si applica a tutti i tipi di cartucce tranne le 32x8 e le 72x2. Consente 
di stabilire se il risultato di un analita deve essere ombreggiato in rosa chiaro nella vista 
Result Summary (Riepilogo dei risultati) quando il relativo CV percentuale è maggiore o 
uguale alla soglia specificata. Se si seleziona l’impostazione Use Filter (Usa Filtro), il CV e 
la soglia applicabili sono determinati dalle impostazioni GnrFilter (FiltroGnr) e 
GnrFilterPercentCVThreshold (SogliaCVPercentualeFiltroGnr). Il valore predefinito è 
UseFilterSetting (UsaImpostazioneFiltro).

ResultWarningHighCVPercent 
Threshold (AvvertenzaRisultato 
SogliaCVPercentualeAlto)

Il CV percentuale utilizzato da ResultWarning (AvvertenzaRisultato). Il valore 
predefinito è 10.

ResultWarning2Gnrs (AvvertenzaRisultato2Gnr)
Questa impostazione si applica solo alle cartucce del tipo 32x8 e 72x2. Consente di 
stabilire se il risultato di un analita deve essere ombreggiato in rosa chiaro nella vista 
Result Summary (Riepilogo dei risultati) quando il relativo CV percentuale è maggiore o 
uguale alla soglia specificata. Il valore predefinito è Off (Disattivata).

ResultWarning2GnrsHighCVPercentThreshold 
(AvvertenzaRisultatoSogliaCVPercentuale 
Alto2Gnr)

Il CV percentuale utilizzato da ResultWarning2Gnrs (AvvertenzaRisultato2Gnr). Il valore 
predefinito è 20.

TA B E L L A //  04

Impostazioni di Runner CE.
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Parametro Descrizione

AutoExportKitResults  
SummaryReport (RiepilogoRisultati 
EsportazioneAutomaticaRisultatiKit)

Consente di stabilire se esportare automaticamente un report riepilogativo dei 
risultati del kit al termine di una sessione analitica e ogni volta che il file dei 
risultati del kit viene salvato. La posizione e il nome del file saranno identici a 
quelli del file dei risultati del kit (.cydat o .ecydat); solo l’estensione del file sarà 
modificata in .pdf

DemoModeEnable (ModalitàDemoAbilitata) L’applicazione funzionerà in modalità demo e non richiede il collegamento di un 
sistema Ella.

KitRunDataRepositoryEnabled 
(ArchivioDatiSessioneKitAbilitato)

Consente di stabilire se l’archivio di dati della sessione analitica del kit (KRDR) 
deve essere abilitato. Il KRDR include tutti i dati della sessione diagnostica 
relativi a un kit oltre a un backup del file dei risultati del kit. Se l’opzione è 
disabilitata, non sarà possibile recuperare il file dei risultati del kit.

KitRunDataRepository (ArchivioDatiSessioneKit)
La directory principale in cui memorizzare tutti i dati delle sessioni diagnostiche 
relativi a un kit oltre a un backup del file dei risultati del kit. Le cartelle sono 
organizzate per data e quindi per ID del kit con l’ora di esecuzione.

LocalKitRunDataRepository 
AutoPurgeEnabled (EliminazioneAutomatica 
ArchivioLocaleDatiSessioneKit)

Consente di stabilire se i dati meno recenti in un archivio di dati della sessione 
analitica del kit (KRDR) locale debbano essere eliminati automaticamente. La 
funzionalità di eliminazione automatica non viene applicata a un KRDR su 
un’unità o una condivisione di rete

LocalKitRunDataRepository 
AutoPurgeDaysToRetain (GiorniDiConservazione 
EliminazioneAutomaticaArchivioLocaleDatiSessioneKit)

Consente di stabilire il numero di giorni di conservazione dei dati se l’opzione 
LocalKitRunDataRepositoryAutoPurgeEnabled 
(EliminazioneAutomaticaArchivioLocaleDatiSessioneKit) è impostata su true 
(vero). Il numero predefinito di giorni per la conservazione dei dati locali della 
sessione analitica del kit è 90.

Generate2DMeasureScanData 
(GeneraDatiScansioneMisurazioni2D)

Consente di generare ulteriori dati diagnostici per le scansioni di misurazione. 
Consente di aumentare lo spazio utilizzato dall’archivio di dati della sessione 
analitica del kit fino al 25%. Il valore predefinito è true (vero).

AutoExportKitResultsTo 
GenericLIMSFile (Esportazione 
AutomaticaRisultatiKitAFileLIMSGenerico)

Consente di stabilire se generare o meno automaticamente un file di 
esportazione LIMS generico al termine della sessione analitica.

GenericLIMSExportFileDefault 
Folder (CartellaPredefinitaFileEsportazioneLIMSGenerico)

Posizione predefinita della directory in cui generare automaticamente il file di 
esportazione LIMS generico (*.csv).

GenericLIMSAutoExport 
AppendSampleAggregateData (EsportazioneAutomatica 
LIMSGenericoAggiungiDatiAggregatiCampioni)

Quando è true (vero), i dati aggregati dei campioni vengono aggiunti alla fine del 
file di esportazione LIMS generato automaticamente.

GenericLIMSAutoExport 
ColumnsSameAsImport (EsportazioneAutomaticaLIMS 
GenericoColonneComeImportazione)

Consente di stabilire se il file di esportazione LIMS generico generato 
automaticamente debba utilizzare o meno le stesse colonne del file di 
importazione (se disponibile). In caso contrario, viene utilizzato il formato 
predefinito.

ShowConcentrationOutOf 
RangeIndicationForExport 
(MostraIndicazioneConcentrazione 
FuoriIntervalloPerEsportazione)

Quando è true (vero), i valori di concentrazione fuori intervallo da esportare sul 
file LIMS generico vengono mostrati come LLOQ o ULOQ in scala del fattore di 
diluizione con un prefisso di ’<’ o ’>’ (come ’< 2,00’ o ’> 5.000’). Altrimenti, se 
false (falso), i campi dei valori di concentrazione fuori intervallo vengono lasciati 
vuoti

GenericLIMSImportFileDefault 
Folder (CartellaPredefinitaFileImportazioneLIMSGenerico)

Posizione predefinita della directory per la scelta del file di importazione LIMS 
generico (*.csv).

UseGenericLIMSImportFile 
DefaultFolder 
(UsaCartellaPredefinitaFileImportazioneLMSGenerico)

Consente di stabilire se utilizzare o meno la directory predefinita specificata in 
GenericLIMSImportFileDefaultFolder 
(CartellaPredefinitaFileImportazioneLIMSGenerico). Se la directory predefinita 
non viene utilizzata, si passa automaticamente a quella utilizzata più di recente.

ComPortName (NomePortaComunicazione) Porta di comunicazione con lo strumento.

BarcodeScannerComPortName 
(NomePortaCounicazioneLettoreCodiciABarre) Porta di comunicazione con il lettore di codici a barre.

BeepOnRunError 
(EmettiSegnaleAcusticoSuErroreSessione)

Indica se Ella deve emettere un segnale acustico quando si verifica una 
condizione di errore durante una sessione analitica per attirare l’attenzione 
dell’utilizzatore.

RequireCartridgeBarcodeScan 
(RichiediScansioneCodiceABarreCartuccia)

Consente di richiedere la scansione del codice a barre della cartuccia nel 
riquadro New Kit (Nuovo kit).

SelfTestDataRepository (ArchivioDatiAutoTest) La directory principale in cui memorizzare tutti i dati dell’autotest. Le cartelle 
sono organizzate per numero Ella e quindi per data e ora del test.

TA B E L L A //  04

Impostazioni di Runner CE.
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Gli archivi di dati
Il software Simple Plex Runner CE è configurato per memorizzare i dati associati a ciascun kit e ad ogni sessione 
di autotest. I dati vengono inseriti in archivi di dati organizzati per data e sessione analitica.

Archivio di dati della sessione analitica del kit 
(KRDR)

•	 Consente di eseguire il backup/recupero dei CYDAT 
per ogni sessione analitica del kit.

•	 Fornisce i dati diagnostici nell’eventualità di 
problemi al sistema.

 Archivio di dati dell’autotest (STDR)

•	 Fornisce una cronologia recuperabile di tutte le 
sessioni di autotest.

•	 Fornisce dati diagnostici nell’eventualità di problemi 
al sistema.

La posizione degli archivi può essere configurata utilizzando le impostazioni dell’applicazione Simple Plex Runner CE.

Recupero di un CYDAT
Se si utilizza il KRDR e si è smarrito o si è perso un CYDAT relativo a una sessione analitica, è possibile recuperare 
il CYDAT di quel kit utilizzando l’opzione Recover Kit Results (Ripristina i risultati del kit) disponibile nel software 
Simple Plex Runner CE in File > Recover Kit Results (File > Ripristina i risultati del kit). Selezionando questa 
opzione, il CYDAT del kit specificato viene individuato nell’archivio e ne viene eseguita una copia nella posizione 
di archiviazione desiderata.

Ricerca/recupero degli autotest
Selezionando l’opzione Self Test History (Cronologia auto-test) nel software Simple Plex Runner CE in Tools > 
Self Test History (Strumenti > Cronologia auto-test), è possibile visualizzare un elenco di tutti gli auto-test 
nell’archivio organizzato per sistema Ella e data. È inoltre possibile recuperare/salvare uno o più report di autotest 
e visualizzare i dettagli dei risultati di qualsiasi autotest.

20W-DOC-0026 Rev B Capitolo 3



Capitolo 4

Manutenzione  
di Ella
Introduzione
In questo capitolo si descrivono le attività di 
manutenzione e assistenza per Ella. Per accedere a 
Simple Plex Runner CE, consultare il Capitolo 3.

Uso del menu Strumenti di Simple Plex 
Runner CE 

Il menu Tools (Strumenti) (Figura 11) viene utilizzato 
per spostare la pedana XY in posizioni predefinite (lo 
spostamento deve essere effettuato con il morsetto e 
il coperchio chiusi) ed esportare i registri diagnostici 
di sistema in un file compresso per l’uso da parte del 
Supporto tecnico.
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Menu Tools (Strumenti) di Simple Plex 
Runner CE.

Autotest del sistema Ella
La cartuccia di verifica di Ella consente al sistema di eseguire una serie di test diagnostici per garantire il corretto 
funzionamento dello strumento. Il software Runner CE supporta i meccanismi per eseguire un autotest; tuttavia, 
per poter eseguire il test, la GUI deve essere progettata dallo sviluppatore del dosaggio. Per informazioni o 
assistenza sullo sviluppo di una GUI, contattare Bio-Techne. 

I risultati verranno inseriti in tabelle nei file di registro del sistema. Questi risultati forniscono preziose informazioni 
al personale Bio-Techne per la risoluzione dei problemi, nel caso in cui sia necessaria la manutenzione del 
sistema. Di conseguenza, si consiglia di utilizzare la cartuccia di verifica una volta alla settimana per creare una 
cronologia delle prestazioni del sistema.

La cartuccia di verifica viene fornita in una scatola di conservazione come mostrato nelle Figure 12 A e B. Quando si 
utilizza la cartuccia di verifica, indossare i guanti per evitare che si sporchi. La cartuccia di verifica è dotata di una 
superficie per sigillare l’interfaccia pneumatica di Ella e di una superficie a fluorescenza automatica come riferimento RFU.
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Cartuccia di verifica Ella.

A. 
Scatola della cartuccia 
di verifica.

B. 
Cartuccia nella scatola, 
codice a barre in su.

ATTENZIONE: non utilizzare una cartuccia di verifica dopo la data di scadenza. Questa data viene 
visualizzata sulla cartuccia o sulla relativa certificazione di calibrazione 

Uso dei comandi Sposta in nel menu del software Simple Plex Runner CE 
Aprire Simple Plex Runner CE

Posizione della finestra dell’obiettivo 
Il comando Tools > Move To > Objective Window Position (Strumenti > Sposta in > Posizione finestra 
dell’obiettivo) consente di spostarsi nella posizione corretta per rimuovere o installare la finestra dell’obiettivo 
inserita nella piastra del riscaldatore. 
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ATTENZIONE: non utilizzare il sistema se il cavo di alimentazione presenta qualsiasi tipo di danneggiamento.

Posizione di caricamento della cartuccia 
Il comando Tools > Move To > Cartridge Load Position (Strumenti > Sposta in > Posizione di caricamento della 
cartuccia) viene fornito per tornare alla posizione di caricamento se in precedenza si è passati alla posizione della 
finestra dell’obiettivo o alla posizione di spedizione. Viene inoltre fornito nell’eventualità che lo strumento non 
rimetta la pedana in posizione di caricamento. In tal caso, rivolgersi al Supporto tecnico Bio-Techne. 

Posizione di spedizione 
Il comando Tools > Move To > Ship Position (Strumenti > Sposta in > Posizione di spedizione) viene fornito nel 
caso in cui Ella debba essere imballato per la spedizione.

Preparazione di Ella per la spedizione
Per preparare Ella per la spedizione:

1.	 Chiudere il morsetto e il coperchio

2.	Fare clic su Tools > Move To > Ship Position (Strumenti > Sposta in > Posizione di spedizione) nel menu Simple 
Plex Runner CE.

3.	Attendere la chiusura della finestra di dialogo a comparsa Moving to shipping position (Spostamento alla 
posizione di spedizione).

4.	Spegnimento di Ella:

a.	 Chiudere Simple Plex Runner CE facendo clic su File > Exit (File > Esci) dal menu o su Close (Chiudi) (X) 
nell’angolo in alto a destra della finestra dell’applicazione. Chiudere il software. Spegnere il computer di Ella

b.	Spegnere Ella premendo l’interruttore di alimentazione sul pannello posteriore.

Esportazione dei registri di sistema
Aprire Simple Plex Runner CE

Facendo clic su Tools > Export Diagnostic Data for Technical Support (Strumenti > Esporta dati diagnostici per 
il Supporto tecnico) le informazioni diagnostiche vengono esportate in un file zip compresso, se richiesto dal 
Supporto tecnico.

Manutenzione e pulizia
Ella richiede una manutenzione preventiva annuale eseguita da un rappresentante Bio-Techne. In caso 
contrario, non è necessaria alcuna calibrazione da parte dell’utilizzatore. Detto ciò, si consiglia di eseguire 
ispezioni periodiche del sistema. Prendere nota di eventuali danni all’involucro di Ella o all’isolamento dei cavi 
associati. Se il danno all’involucro indica che la protezione dei componenti elettronici dall’infiltrazione di umidità 
o dalla luce laser è compromessa o sta per essere compromessa, o se il danno al cavo suggerisce che corto 
circuiti o aperture dei collegamenti elettrici sono imminenti, adottare misure correttive appropriate a seconda 
della situazione, in casi estremi la messa fuori servizio del prodotto fino all’esecuzione delle riparazioni. Per 
informazioni sulle riparazioni e le parti di ricambio, contattare il Servizio clienti.

Di seguito sono riportati i materiali necessari per una corretta manutenzione e pulizia di Ella:

1.	 Soluzione di candeggina per uso domestico al 10%

2.	Soluzione di etanolo al 70%

3.	Detergente delicato

4.	Panni puliti che non lasciano residui

5.	Salviette monouso per lenti (opzionali)
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ATTENZIONE: non pulire la superficie esterna con etanolo.

ATTENZIONE: quando si pulisce la finestra 
dell’obiettivo

•	 Non utilizzare candeggina

•	 Toccare la finestra dell’obiettivo solo con il 
panno non abrasivo

ATTENZIONE: durante la pulizia del vano, prestare attenzione a non contaminare la finestra dell’obiettivo.

Pulizia del vano della cartuccia e della finestra dell’obiettivo
Vano della cartuccia

Se necessario, il vano della cartuccia di Ella può essere pulito con una salvietta non abrasiva che non lascia 
residui inumidita con etanolo al 70%. 

Finestra dell’obiettivo

Assicurarsi che la finestra dell’obiettivo sia sempre 
pulita. Se occorre effettuare la pulizia, utilizzare una 
salvietta pulita, non abrasiva, che non lascia residui, 
inumidita con un detergente delicato o con etanolo al 
70% fino a quando la finestra non risulta senza aloni. 
Per assicurarsi che la finestra dell’obiettivo sia pulita 
(senza aloni), si consiglia di utilizzare più salviette 
monouso (vedere la Figura 13).
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Vano della cartuccia e finestra dell’obiettivo.

Finestra dell’obiettivo

Vano della cartuccia

Pulizia e manutenzione del filtro della ventola
Ella deve sempre ricevere una ventilazione adeguata per il raffreddamento. Affinché Ella soddisfi le specifiche 
ed eviti il surriscaldamento, è necessario che il raffreddamento sia adeguato. La manutenzione periodica dello 
strumento deve includere l’ispezione e la pulizia del filtro della ventola ogni sei mesi.

Per pulire il filtro:

1.	 Rimuovere la griglia della ventola e il filtro della ventola.

2.	Pulire il filtro della ventola con l’aspirapolvere.

3.	Se necessario, sostituire i filtri della ventola usurati o danneggiati (PN 541401).

4.	Reinstallare il filtro della ventola e la griglia di protezione della ventola.

Pulizia della superficie esterna
Spegnere e scollegare Ella prima di eseguire la pulizia. Se necessario, pulire tutte le superfici esterne di Ella solo 
con un panno umido non abrasivo che può essere inumidito con un detergente delicato. Inoltre, se occorre pulire 
gli accessori, come il cavo USB o il lettore di codici a barre, è possibile farlo sempre utilizzando solo un panno 
umido non abrasivo che può essere inumidito con un detergente delicato.
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